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Get	the	best	out	of	your	photos	with	these	basic	photo	editing	methods.	With	the	Decorate	tool,	you	can	crop	edges,	change	the	shape	and	size	of	your	photo,	and	even	straighten	the	curvature	of	a	border	or	horizon.	open	file	(0:41);	Crop	(0:57);	Fix	it	(2:04),	(2:50)	improve	the	lighting	and	color,	make	the	photo	easier	and	color	it	with	adjustable
layers.	brightness/contrast	(0:18);	hue/saturation	(1:20);	It's	easy	to	remove	distractions	with	the	Edit	Adjustment	Tool	(04:19),	the	Spot	Brush,	and	the	Correction	Tool.	Fixing	Tool	(3:00)	Turn	colors	to	black/white/white,	add	an	old-fashioned	tonal	look,	and	play	with	sharpness	with	the	blur	blur	filter.	Tilt	filter	(0:57);	Black	and	White	(02:26);	Color
tone	(02:56)	Apply	the	Zapotek	filter	to	the	photo	in	the	next	shot.	Then	save	the	edited	file	in	PSD	format	to	save	the	layers	for	future	editing.	Save	a	copy	of	your	photo	as	a	jpeg	file	to	share	online	or	via	email.	pain	(0:10);	Save	(2:50);	Photoshop	with	Lightroom	and	mobile	apps	(4:14).	Free	online	photo	editor	supporting	PSD,	XCF,	Sketch,	XD	and
CDR	formats.	(Adobe	Photoshop,	Gimp,	Sketch	app,	Adobe	XD	and	Coreldraw).	Create	a	new	image	or	open	existing	files	from	your	computer.	Save	your	work	as	PSD	(File	-	Save	as	PSD)	or	JPG	/	PNG	/	SVG	(File	-	Export).	Deliver	new	features	to	GitHub	or	our	Facebook.	Our	goal	is	to	create	the	most	advanced	and	accessible	photo	editor.
Support@photopea.com	|	Reddit:	/r	/photopea	|	Photoshop	Privacy	Policy	is	one	of	the	most	powerful	image	editing	software	you	can	buy.	With	the	best	tools	and	mods	around	the	layer,	there	is	no	reason	not	to	use	this	program.	The	thing	is,	if	you've	tried	to	edit	Photoshop,	you've	probably	felt	a	little	lost.	With	so	many	features,	it's	hard	to	decide
where	to	start.	Luckily,	check	out	how	to	edit	photos	in	Photoshop	when	it's	easier	with	these	10	simple,	quick	methods.	For	professional	Photoshop	editing,	follow	these	10	quick	recipes:	import	your	photos,	straighten	them,	create	a	large	exposure	of	white	balance	and	adjust	with	raw	camera,	remove	any	noise	from	a	photo	by	clone	with	the
Handorime	clone	and	contrast	tool.	Crispy	Crisp	Crisp	Layers	Create	color	parameters	Create	point	settings	with	mask	layers,	prevent	and	burn	in	your	photos.Get	the	best	out	of	your	photos	with	these	basic	photo	editing	techniques.	With	the	crop	tool,	you	can	crop	the	edges,	change	the	shape	and	size	of	the	photo,	and	even	straighten	the	coastline
or	curved	horizon.	Open	files	(0:41);	Retaglia	(0:57);	Radrice	(2:04),	Salva	(2:50)	Color	Illumination	and	Enhance	illustrates	your	photo	and	brings	its	colors	to	life	with	a	level	of	adjustment.	Brightness/Contrast	(0:18);	Hues/Saturation	(1:20);	Edit	edit	(04:19)	Remove	distraction	with	the	correction	brush	on	the	fly	and	fix	the	correction	brush	on	the
fly	(00:53);	Correction	Tool	(3:00)	Convert	B&W,	add	a	look	with	vintage	tones,	and	play	with	Focus	with	tilt-shift	flash.	Smart	filters	(0:16);	Tilt	Link	Blur	Filter	(0:57);	black	and	white	(02:26);	Shadow	(02:56)	applies	a	sharpening	filter	to	fill	the	photo.	Then	save	the	modified	file	in	PSD	format	to	save	the	levels	for	future	changes.	To	share	your	photo
online	or	via	email	By	mail,	save	a	copy	as	a	JPEG.	Focusing	(0:10);	Save	(2:50);	Photoshop	with	Lightroom	and	Mobile	App	(4:14)	Free	online	photo	editor	that	supports	PSD,	XCF,	Sketch,	XD	and	CDR	formats.	(Adobe	Photoshop,	Gimp,	Eskich,	Adobe	XD	and	CorelDraw).	Create	a	new	image	or	open	files	from	your	computer.	Save	your	work	as	PSD
(File	-	Save	as	PSD)	or	as	JPG/PNG/SVG	(File	-	Export).	Suggest	new	features	on	our	GitHub	or	Facebook.	Our	goal	is	to	create	the	most	advanced	and	user-friendly	photo	editor.	support@phototopea.com	|	Reddit:	/r	/fotopea	|	Privacy	Photoshop	is	one	of	the	most	powerful	photo	editors	money	can	buy.	With	some	top-notch	tools	and	tweaks,	there's	no
reason	not	to	use	this	app.	The	problem	is,	if	you've	tried	to	edit	a	photo	in	Photoshop,	you've	probably	felt	a	little	lost.	With	so	much	functionality,	it's	hard	to	know	where	to	start.	Fortunately,	this	simple	method	in	10	steps	made	it	easier	to	learn	how	to	edit	photos	in	Photoshop.	Follow	this	recipe	in	10	steps	to	professionally	edit	a	photo	in
Photoshop:	this	is	important	to	your	photos,	crop	them	and	straighten	them	if	necessary.	This	provides	basic	exposure	and	white	balance	adjustments	with	raw	cameras.	Remove	all	distractions	from	your	photo	using	the	Clone	stamp	tool	level	in	the	Curves	adjustment	layer.These	10	steps	will	make	it	easier	for	you	to	know	what	to	do	next.	With	a
clear	roadmap,	Photoshop	will	be	much	less	intimidating	and	you'll	be	able	to	get	from	point	A	to	point	B	in	less	time.	Now	let's	go	through	each	of	these	10	steps	together!	How	to	professionally	edit	photos	in	Photoshop	-	step	by	step.	The	photo	I	use	in	this	tutorial	is	the	most	recent	photo	of	the	waterfall.	Once	you've	mastered	the	10-step	editing
recipe,	you	can	take	this	photo	to	a	whole	new	level.	If	you	want	to	participate,	feel	free	to	show	me	your	photo	so	we	can	do	it	together.	Since	each	edited	photo	requires	different	adjustments,	I	will	only	share	my	general	steps.	The	exact	settings	I	use	for	each	tool	don't	matter	as	they	will	look	different	in	your	images.	The	point	is	to	give	you	a	guide
on	how	to	go	through	the	process	of	taking	photos	in	Photoshop.	This	is	the	workflow	I've	developed	over	the	years	and	I	find	it	the	most	effective	at	getting	consistent	results!	How	to	do	it.	1.	Import	your	images.	This	may	be	obvious,	but	first	you	need	to	import	your	photo	into	Photoshop.	Depending	on	where	the	photo	is	stored,	there	are	two
different	ways	to	do	this.	Option	1:	Open	a	new	document	The	first	option	is	to	open	the	photo	directly	in	Photoshop	from	your	computer.	To	do	this,	simply	press	Command	+	O	(Mac)	or	Ctrl	+	O	(PC)	on	your	keyboard.	Alternatively,	you	can	click	Open	on	the	Photoshop	splash	screen.	Since	this	option	shoots	directly	from	your	computer	into
Photoshop,	you'll	need	to	remember	to	save	your	project	later.	Without	developing	another	program	like	Lightroom,	Photoshop	asks	you	to	choose	a	location	on	your	computer	to	save	your	project.	You	will	be	asked	when	trying	to	save	the	project.	There	are	no	downsides	to	this,	but	it's	easier	to	screw	up	project	files.	When	saving	Photoshop	projects,
make	sure	you	have	a	folder	to	organize.	Then	you	can	easily	find	them	later!	Option	2:	Open	a	Lightroom	photo	in	Photoshop	If	your	photo	has	already	been	imported	into	Lightroom,	you	can	start	editing	the	same	file	in	Photoshop.	Just	right-click	on	the	photo	you	want	and	select	Edit	>	Photoshop.	From	now	on,	your	photo	will	automatically	open	in
Photoshop	and	be	ready	to	use.	The	difference	with	this	method	is	that	after	saving	the	project,	the	newLightroom	will	appear.	Instead	of	editing	Photoshop	project	files,	Lightroom	will	do	this	for	you	and	keep	the	project	file	in	the	same	place	as	the	original	image.	2.	Demines	and	Gray	(if	necessary)	If	your	photo	appears	a	little	distorted	or	you	have
to	edit	the	framework,	all	your	concerns	solve	the	use	of	the	termination	tool.	You	can	quickly	open	a	C	button	on	the	keyboard	or	access	a	toolbar	with	the	dry	tool.	Optionally,	you	will	notice	the	white	frame	around	the	picture	and	set	the	vehicle	into	the	upper	pole.	For	normal	use,	make	sure	that	your	front	setting	is	set	to	"W	x	X	V	X	resolution".
With	this	harvest	you	can	freely	adapt	the	earnings	size.	In	this	way	you	can	use	the	"original	relationship"	selection	if	you	have	to	keep	the	same	edge	ratio	during	correction.	Then	make	sure	that	the	ability	to	"delete	cut	pixels"	is	closed.	In	this	way,	all	image	information	will	be	there	when	cutting	the	photo.	This	is	the	best	way	to	shorten	the
unwanted	ones	and	also	gives	you	the	opportunity	to	change	your	opinion	later.	Click	on	an	overlap	on	the	outer	edge	of	the	overlap	to	reverse	the	photo.	This	moves	the	speed	and	darker	all	fields	of	photography	that	are	no	longer	visible.	The	aim	is	to	better	concentrate	on	the	object	or	to	cut	the	photo	to	quickly	remove	worrying	elements	on	the
edge	of	the	frame.	If	you	don't	believe	that	you	should	cut	your	photo,	it's	okay.	It	is	only	important	to	think	if	you	have	to	copy	at	the	beginning	of	each	correction.	Â	»Follow	the	smoothing	tool	with	a	simple	tool.	This	tool	is	ideal	for	correcting	inclined	horizons	or	editing	a	photo	that	is	to	be	used	with	a	certain	edge.	In	most	cases,	use	this	tool	along
the	horizon	lines.	The	smoothing	tool	can	access	the	cutting	tool	on	the	top	of	the	screen.	The	icon	is	a	small	bladder	spirit	with	a	dotted	curved	line.	When	you	are	active,	click	on	the	horizon	and	pull	it.	During	the	drawing,	the	line	on	which	the	settlement	corrections	are	based	is	formed.	Give	your	best	to	meet	your	horizon	or	edge.	Photoshop	knows
exactly	which	edge	you	want	to	be	perfect!	After	the	version,	your	image	is	automatically	corrected	in	such	a	way	that	it	matches	the	line	you	have	created.	If	your	photo	is	very	broken,	you	will	find	that	most	of	your	picture	may	have.To	adapt	to	a	significant	change	in	angle,	in	some	cases	it	only	works	by	clipping	and	hitting	the	photo.	So	it's	always
better	to	do	things	with	the	camera!	Why	cut	and	smooth	the	first	step	in	the	team?	Make	sure	your	photo	doesn't	look	twisted,	it's	essential	for	installation.	You	can	waste	time	adjusting	the	part	of	the	photo	that	may	not	be	considered	after	the	change.	To	keep	a	step	forward,	the	photo	will	reappear	from	the	beginning	and	smooth	the	photo.
Therefore,	it	remains	to	adjust	the	exhibition	and	the	colors!	3.	Adding	basic	settings	with	a	raw	camera	is	a	handy	tool	in	Photoshop	that	acts	as	a	mini-lightroom.	In	this	tool	you	have	all	the	typical	determinations	of	white	balance,	exposure,	colors	and	spots	that	you	can	expect	in	photo	editor.	The	beauty	of	the	raw	camera	is	that	it	provides	an
effective	way	to	create	basic	photo	regulations.	Basic	corrections	are	generally	needed	to	balance	exposure	and	white	balance	in	the	images.	In	most	cases	you	will	have	an	exhibition	that	supports	reflection	or	shadows.	With	basic	adjustments,	you	can	balance	them	out	and	create	a	more	published	photo	to	work	with.	How	to	open	a	raw	camera
before	I	open	a	raw	camera.	I	definitely	suggest	turning	the	image	plane	into	a	smart	object.	That	way	you	can	always	go	back	and	adjust	the	raw	camera	settings	if	needed.	Learn	more	about	the	power	of	smart	objects	here.	Since	we	only	have	one	image	layer	left,	let's	press	Order	+	J	(Mac)	or	Control	+	J	(PC)	first.	The	second	background	layer
allows	you	to	ensure	that	you	edit	in	a	non-destructive	way.	Then	click	on	the	new	layer	and	select	Convert	to	Smart	Object.	Then	go	to	the	filter	of	the	camera's	raw	filter	and	open	the	selected	layer	in	the	raw	camera.	If	you've	spent	some	time	in	other	publishing	software	like	Lightroom	or	Luminar	in	other	publishing	software,	most	of	what	you	see
here	will	change.	You	can	start	things	off	with	an	exhibition,	reflection,	shadow,	white	and	black	sliders.	First	increase	the	exhibition	cursor	or	reduce	a	good	balance	between	shadows	and	reflections.	It	is	best	to	see	the	details	of	all	exhibitions.	It	will	help	you	to	use	the	histogram	at	the	top	of	the	edit	panel.	Now	work	on	your	strengths,	shadows,
white	andCursors.	Instead	of	adjusting	the	entire	pose,	these	shifts	affect	only	specific	pose	beaches	in	your	photo.	Since	it	breaks	everything,	it	is	much	easier	to	target	certain	parts	of	the	photo.	Continue	to	set	up	these	slides	to	reveal	the	most	clear	and	darkest	parts	of	the	photo.	The	final	result	will	probably	be	a	little	straight	and	weak,	but	we're
after	it.	In	this	way,	you	can	add	a	more	creative	contrast	to	the	next	steps.	Change	the	white	balance	roughly,	after	setting	the	exposure,	make	sure	to	set	the	white	balance	and	tone	to	make	the	photo	be	as	realistic	as	possible.	By	creating	white	balance	or	cold	white,	you	can	create	the	colors	of	your	photos	in	the	future.	To	change	the	white
balance,	just	move	the	temperature	cursor	to	the	left	or	right.	Sliding	to	the	left	makes	your	white	balance	more	blue	and	shift	to	the	right	makes	it	look	more	yellow.	If	you	need	to	look	100	%white	in	a	particular	area	of	the	photo,	click	the	tower	tools	on	the	balance	bolts.	With	this	tool,	you	can	click	to	illustrate	any	color	in	a	photo,	and	the	Camera
Raw	sets	the	white	balance	to	fit	that	particular	area.	In	most	cases,	you	adjust	the	white	balance	using	your	common	sense.	After	changing	the	color	temperature,	the	photo	can	be	a	little	purple	or	green.	Especially	when	shooting	with	an	ND	filter	or	a	polarizer,	sometimes	this	happens.	Fortunately,	you	can	quickly	correct	this	with	the	shadow
cursor.	To	confront	the	shadow	you	see	in	the	photo,	just	shift	to	the	left	or	right.	When	you	are	satisfied	with	your	adjustments,	click	OK	to	get	out	of	the	raw	camera.	4.	Remove	all	the	distractor	elements	in	the	photo,	with	the	basic	settings,	it	is	time	to	remove	all	unwanted	attention	distributing	elements	in	the	photo.	It	can	be	as	small	as	a	sensor
as	big	as	the	whole	building.	Anything	you	need	to	remove	from	an	image	can	be	done	with	two	simple	tools	in	Photoshop.	Clone	stamp	tool	clone	stamp	tool	is	one	of	the	best	tools	to	remove	objects	in	Photoshop.	Instead	of	automatically	selecting	the	place	that	Photoshop	thinks	will	work	best,	you	can	define	the	sampling	area	manually.	This	gives
you	more	flexibility	when	working	with	models,	complex	edges	or	often	challenging	content	-sensitive	methods.	Configuration	of	Stamp	Cloning	Vehicle	Press	S	button	to	access	the	stamp	cloning	toolor	find	it	on	the	toolbar.	Then	create	a	new	layer	in	which	you	will	make	corrections	to	the	maple	stamp.	In	this	way	you	can	continue	the	non	-
destructive	edition.	In	the	Clone	Stamp	settings	panel,	make	sure	your	mode	is	set	to	normal,	coverage	and	flow	are	set	100%and	the	sample	is	set	to	current	and	lower.	If	you	have	never	worked	with	a	stamp	tool,	it	works	very	similar	to	the	usual	brush	tool.	The	only	difference	is	that	it	colors	the	selected	area	instead	of	a	uniform	color.	In	most
cases,	you	want	the	new	cloned	area	to	blend	in	with	the	rest	of	the	photo.	It's	best	to	do	it	with	a	soft	edge	brush.	Click	the	brush	settings	palette	and	select	the	"Soft	Round"	brush	setting.	Change	hardness	to	any	value	from	0%	to	25%	to	get	the	best	results	thanks	to	the	Clone	Stamp	settings.	As	for	the	brush	size,	you	need	to	change	it,	so	use	the
abbreviation	key	[or]	to	increase	or	reduce	the	brush	size.	Once	you	have	all	the	cloning	stamp	settings,	it's	time	to	start	removing	objects	from	the	photo.	In	this	case,	I	want	to	remove	a	fallen	tree	on	the	right	of	my	photo.	With	a	large	empty	sampler	nearby,	it	will	be	easy	to	remove.	â	removing	objects	from	a	photo	using	a	cloning	stamp	every	time
you	try	to	remove	something	from	a	photo,	remember	that	you	need	to	find	a	place	that	will	replace	it.	The	more	area	you	can	download	(in	this	case	rocks),	the	easier	it	will	be	thoroughly	clone	the	objects.	It	can	be	difficult	if	the	area	has	patterns	or	has	nothing	to	fill.	I	will	start	by	holding	Alt	or	Option	(PC/MAC)	and	clicking	anywhere	in	the
preview	image.	The	template	will	be	used	to	clone	the	object	from	anywhere.	Because	I	take	samples	of	surrounding	rocks,	they	mix	well	and	clone	a	fallen	tree.	With	a	small	brush	I	slowly	crossed	the	fallen	tree.	To	get	the	most	realistic	look,	use	a	small	brush	to	make	the	cloning	match	less	noticeable.	Spending	time	with	a	small	brush	is	very
helpful.	Continuing	the	cloning	of	the	photo,	you	will	have	to	take	samples	of	new	areas.	In	an	ideal	case,	the	sample	is	taken	as	close	as	possible	to	the	object,	so	that	the	new	exhibition	and	textures	fit	into	the	surrounding	area.	Repeat	these	activities	until	you	get	rid	of	all	distracting	elements	in	the	photo.	When	you	finish,	change	the	name	of	the
layer	to	"maple"	so	that	everything	is	ordered.	Point	healing	brush	not	all	elements	must	be	removedStamp	tool.	Many	of	your	photos	show	that	the	things	you	have	to	remove	are	small.	Since	the	selection	is	not	so	specific,	these	small	objects	can	be	automatically	removed	with	the	correction	brush.	The	DOT	Healing	Brush	works	through	content
knowing	that	you	will	find	a	sample	area	to	replace	your	selection.	All	you	have	to	do	is	fill	in	the	object	you	want	to	replace.	To	access	the	correction	brush	on	the	fly	tool,	press	the	J	key	or	look	for	it	in	the	toolbar.	If	you	don't	see	it,	keep	the	correction	brush	icon	and	explore	the	tool's	other	options.	To	set	up	the	tool,	make	sure	you	use	a	brush
hardness	between	0%	and	25%	and	a	25%	brush,	the	mode	should	be	set	to	normal	and	the	type	should	be	contained.	,	select	"Read	All	Layers"	to	make	this	tool	easier	to	use.	You	can	resize	the	brush	using	the	keys	from	the	left	and	right	square	brackets	[O].	This	photo	shows	the	leaves	sprinkled	on	the	rocks	below	the	waterfall	that	I	want	to	get	rid
of.	Since	they	are	so	small,	the	Remedial	Brushes	tool	will	be	excellent	for	removing	them	on	the	fly.	When	painting	over	the	areas	you	want	to	get	rid	of,	in	the	photo	it	appears	that	the	half-hearted,	half-hearted	black	brush	represents	the	selection	area.	Photoshop	will	automatically	replace	this	black	brush	with	something	suitable	to	replace	this	part
of	the	image.	Repeat	this	process	at	the	same	"clone"	level	until	all	small	distractions	are	removed.	Looking	before	and	after	using	both	the	clone	stamp	and	the	brush	tools	on	the	shoe,	the	photo	appears	much	cleaner.	These	are	the	two	most	useful	tools	that	you	can	use	in	any	situation.	5.	Improve	exposure	and	contrast	with	curves,	now	all	the
initial	work	is	not	much.	The	image	has	a	balanced	exposure,	there	are	no	distractions,	and	now	it's	time	to	add	your	creative	touch.	First,	we'll	improve	the	exposure	and	contrast	using	the	curve	adjustment	level.	New	Curve	Adjustment	Level	To	create	a	new	curve	adjustment	level,	click	the	curved	rule	icon	on	the	Rules	tab.	You	can	also	find	it	by
clicking	the	settings	icon	at	the	bottom	of	the	panel.	Both	will	get	the	same	result!	Since	the	curve	is	adjusted,	if	you	are	familiar	with	Lightroom's	tone	curve,	this	level	of	adjustment	will	be	very	similar.	In	short,	the	curve	is	brokenIn	4	different	sections	displayed	in	a	grid.	The	columns	are	horizontal	from	the	left	and	represent	shadows	(left),	darks,
lights,	and	highlights	(right).	The	white	line	represents	its	exhibition	in	all	these	sections.	Clicking	and	swiping	anywhere	will	ease	you	through	all	the	beaches	in	the	show.	Meanwhile,	as	you	slide	down,	the	World's	Fair.	If	you	click	on	different	areas	of	the	curve,	you	can	still	add	new	ports	to	the	exposure	and	tweak	the	contrast.	For	example,	you
can	reduce	the	shadows	and	increase	the	highlights	to	add	more	contrast.	Play	around	with	your	curve	settings	to	see	what	type	of	exposure	and	contrast	settings	work	best	for	your	photo.	This	article	provides	an	overview	of	the	different	shapes	of	curves	that	you	can	use	for	certain	effects.	If	you	are	satisfied	with	the	parameters	of	the	curve,	you
need	to	define	a	good	general,	opposite	and	exposure.	Whichever	suits	your	streaming	style	better	and	highlights	the	photo.	6.	Make	general	changes	to	the	colors	of	your	photo	after	stress	and	contrast,	the	color	appears.	Photoshop	has	some	fantastic	tools	to	change	the	colors	of	your	image.	But	these	three	are	the	most	effective.	Setting	1:	In	the
Selective	Color	Selective	Color	Positions	tab,	click	the	Selective	Color	icon.	You	can	also	find	the	set	level	symbol	below	the	layer	field.	This	tool	splits	any	exposure	and	color	value	of	your	photo	into	tabs.	By	comparing	different	color	tabs,	you	can	better	improve	the	exposure	and	tones	of	these	areas.	While	there	are	plenty	of	color	channels	that
work,	I	find	using	the	black,	neutral,	and	white	tabs	to	be	really	needed.	The	Selective	Color	layer	contains	four	markers:	Cyan,	Magenta,	Yellow,	and	Black.	If	you	move	one	of	these	markers	to	the	right,	you	will	add	more	than	that	specific	color.	If	you	move	the	object	holder	to	the	left,	you	will	add	all	the	opposite	colors	of	each	object	holder	to	the
photo.	For	reference,	a	life	marker	gives	them	red,	a	magenta	marker	gives	them	green,	and	a	yellow	marker	blue.	Look	at	black,	neutral	and	white	nails	and	set	the	four	scrolls	accordingly.	Do	not	forget	to	exaggerate	this	adaptation,	otherwise	you	will	get	an	unrealistic	look.	Setting	2:	Satisfying	Shadows	This	settingThe	use	for	color	adjustment	is
called	color	saturation.	This	tool	allows	you	to	change	the	color	of	any	photo	and	create	a	unique	look	of	certain	colors.	Click	the	Settings	tab	or	find	it	in	the	layer	panel	to	create	a	new	shadow	saturation	layer.	Click	on	the	Master	tab	after	opening	and	explore	your	individual	color	channels.	Go	through	each	channel,	adjusting	the	shade,	saturation
and	brightness	if	necessary.	If	you	want	to	get	particularly	creative	with	the	editing	of	photos,	don't	be	afraid	to	change	up	some	hues.	It's	all	part	of	the	fun!	3.	Settings:	Color	balance	is	the	last	added	color	adjustment	color	balance	layer.	This	tool	allows	you	to	change	the	range	of	exposure	range.	Instead	of	choosing	a	target	audience	using	color,
you	can	choose	the	photography	space	based	on	their	exhibition.	Click	the	Settings	tab	or	find	it	in	the	layer	panel	to	create	a	new	color	compensation	layer.	Check	the	selected	area	"Save	Brightness"	after	it	opens.	Then	start	playing	with	the	sliders	to	see	what	tones	you	can	make.	Be	sure	to	change	the	probability	of	medium	tones,	shadows,	and
lightened	tones	to	better	incorporate	the	changes.	I	like	to	start	with	the	midtones,	then	adjust	the	shadows	and	highlight	at	the	same	time.	Whatever	your	job,	make	sure	you	use	all	the	tonal	hues!	These	3	color	changes	are	the	result	of	3	different	layers	of	your	photo	settings,	now	a	much	more	professional	look.	These	three	tools	were	created	for
every	photo	I	edited	Photoshop.	Under	the	waterfall	in	the	photo	in	the	photo	and	then!	7.	Create	changes	in	the	field	using	mask	layers,	now	that	you	have	completed	all	the	general	expositions,	contrast	and	color	changes,	it	is	time	to	make	certain	parameters.	You	can	directly	select	a	part	of	the	photo	(such	as	"sky"	or	"object")	using	the	spot
adjustment	and	apply	them.	Unlike	other	editing	programs,	Photoshop	does	not	have	dedicated	"dots	editing"	brushes.	Instead,	you	must	use	mask	layers	to	control	that	the	settings	are	visible.	If	you're	a	newbie	to	using	mask	layers,	make	sure	you	use	the	basics	of	mask	layers	as	much	as	possible.	In	this	example,	I	light	up	the	sky	with	a	soft	brush
on	the	sheet	mask.	You	can	use	any	adaptation	layer	for	correct	replacement.	ButI	want	to	increase	the	heavenly	exposure,	I	use	the	curve	adjustment	layer.	You	can	follow	this	exact	process	with	any	number	of	adjustment	layers.	To	make	a	curve	adjustment,	click	the	curve	correction	icon	on	the	adjustment	tab	or	find	it	in	the	layer	panel.	Since	I
want	to	make	the	photo	brighter,	I	will	only	increase	the	average	shade	exposure.	Using	a	white	layer	mask,	the	entire	image	will	be	illuminated	with	curves.	To	isolate	its	effects,	I	first	turned	the	layer	mask	by	clicking	on	the	mask	and	pressing	the	Command	+	I	(Mac)	or	Control	+	I	(PC).	Now	all	the	curve	adjustments	will	be	invisible,	but	you	can
add	them	with	a	white	brush.	By	taking	the	brush	tool	(b)	and	choosing	a	soft	0%	sound	brush,	I	will	paint	areas	that	I	want	to	make	it	brighter.	In	this	case,	the	sky	and	the	nearby	waterfall.	With	a	layer	of	mask,	you	can	control	more	control	of	the	insulation.	In	this	article	you	can	learn	more	about	using	layers	of	masks.	Which	points	need	to	be
adjusted?	Point	adjustments	are	ideal	for	removing	any	color	variations	in	the	photo	or	highlighting	important	places.	In	many	cases,	by	brightening	objects	or	making	darker	less	important	areas,	photos	can	be	significantly	complemented.	In	the	above	example,	I	only	use	the	custom	layer	of	curves,	but	you	can	do	the	same	with	any	adjustment	layer.
Just	rinse	and	repeat	the	same	process	with	any	color,	contrast	and	exposure	adjustments	if	necessary!	8.	Currently	Dodge	and	Burn	You	are	very	happy	with	the	look	of	your	photo.	But	there	is	another	last	step	you	can	add	to	really	improve	it.	This	step	involves	a	technique	called	avoidance	and	baking.	In	short,	Unique	selectively	illuminates	your
photo	and	selectively	makes	it	darker.	By	switching	between	these	tools	in	Photoshop,	you	can	add	creative	contrast.	•	Make	a	50%	gray	layer	to	edit	the	non	-destructive	effect.	First	you	need	a	50%	gray	layer	to	use	lighting	and	darker	to	the	non	-destructive.	Press	Command	+	Shift	+	N	(Mac)	or	Control	+	Shift	+	N	(PC)	to	open	a	new	layer	of
dialog	box.	Change	the	mixing	mode	to	the	overlay,	set	it	to	50%	gray	fill	and	rename	the	layer	to	avoid	it	and	make	it	darker.	Â	Avoid	an	image	that	starts	with	the	Dodge	tool,	press	o	to	access	it.	When	viewing	the	setting	panel,	leave	the	range	set	to	medium	tones	and	set	the	option	exposure	to	5%	to	10%.	The	higher	the	exposure,	the	stronger	the
adjustmentsSee.	I	find	this	range	works	best	for	the	most	realistic	effects.	With	the	Fade	in	and	out	layer	selected,	start	avoiding	the	areas	of	your	photo	that	you	want	to	draw	more	attention	to.	Things	like	your	theme,	interesting	textures,	or	an	appearance	on	the	horizon.	If	you	want	to	brighten	an	area,	paint	a	few	brush	strokes	in	the	same	area.
Image	compositing	After	reviewing	part	of	the	image,	click	and	hold	the	Dodge	Tool	icon	in	the	toolbar.	In	the	tools	window	that	opens,	select	the	authoring	tool.	Go	back	to	the	Settings	tab,	set	the	range	to	Midtones	and	leave	the	exposure	between	5%	and	10%.	This	time	darken	some	parts	of	the	photo.	Paint	over	the	areas	you	don't	want	to
highlight.	You	can	also	capture	the	edges	of	the	photo	facing	the	light	source.	It	really	brings	out	the	brightest	areas	of	the	image	and	draws	attention	to	the	brighter	areas.	Switch	between	dodge	and	ignite	until	you	like	the	effect.	If	all	goes	well,	you'll	notice	a	small	but	beneficial	change	in	the	contrasting	areas	of	the	photo.	9.	Correct	the	image
with	a	high-pass	filter.	Editing	is	almost	complete.	The	final	touch	is	to	add	expressiveness	to	the	whole	photo.	One	of	my	favorite	ways	to	do	this	is	to	use	a	high-pass	filter.	The	high	pass	filter	enhances	the	edge	details	of	the	photo.	This	will	make	the	whole	picture	clearer.	Since	you	need	to	apply	this	filter	to	the	image,	you	need	to	duplicate	and
merge	the	existing	layers.	Click	the	top	layer	in	the	Layers	panel	and	use	the	keyboard	shortcut	Command+Option+Shift+E	(Mac)	or	Ctrl+Alt+Shift+E	(PC)	to	duplicate	and	merge	all	layers.	With	the	new	merged	layer	selected,	go	to	Filter	>	More	>	High	Throughput.	Set	the	radius	to	no	more	than	2	pixels	and	click	OK.	The	larger	the	radius,	the
more	intense	the	sharpening	will	be.	Finally,	set	the	layer's	blending	mode	from	Normal	to	Linear	Light	to	reveal	the	high-pass	filter.	Also,	don't	forget	to	rename	the	layer	to	"Sharpen"	to	keep	things	tidy!	10.	Exporting	a	photo	from	Photoshop	Now	that	you've	come	this	far,	it's	time	for	the	final	step	in	the	editing	process.	How	to	export	a	photo!
There	are	several	ways	to	export	images	from	Photoshop,	but	let's	consider	the	simplest.	Go	to	File	>	Save	As.	Enter	the	desired	filename	and	location	on	your	computer.Exporting	the	photo	to	now,	the	most	important	thing	is	to	change	the	Photoshop	format	to	JPEG.	Then	click	Save	to	export	the	photo	in	JPEG	format!	Result	after	10	steps,	we
completely	changed	the	photo	of	the	waterfall.	What	started	as	a	fairly	simple	image	has	been	changed	to	better	attract	your	attention.	With	several	layers	and	adjustment	filters,	editing	photos	in	Photoshop	is	easy!	If	you	start	in	the	Photoshop	edition,	it	may	seem	a	little	overwhelming.	Remember	that	with	practice	and	repetition,	these	steps	will
become	second	nature.	It	takes	time	to	develop	a	good	photo	retouching	workflow,	but	once	you	have	done,	editing	any	photo	will	be	a	breeze!	Good	luck	with	your	modifications!	Brendan	ð	ð




